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Introduction

HOW TO USE THIS
RESOURCE

This Master Class is an on-campus learning and orientation experience
for high school students, combining visits to computer labs with an
informative interactive talk on scientific topics related to computer
programming and Robotics. It should be planned so that it can take
place within the university and use available labs or other equipment.
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Activity concept and lesson plan

THEME OF THE
CL AS S

LEVEL OF
DIFFICULTY / AGE
OF STUDENTS

REQUIRED PRIOR
KNOWLEDGE

TIME REQUIRED
FOR
IM PLEM ENTATI ON

INSTRUCTORS

KNOWLEDGE
G AI NE D AND
COMPETENCIES
DEVELOPED STUDENTS

The topic of the training activity is: Introduction to Arduino systems
and to programming for embedded systems built on Arduinо modules.
The approach is based on the use of a ready-made project that is
initially presented to the students, along with information about the
basic programming constructs of the programming language. It hides
the complexity of traditional programming for embedded systems and
microcontrollers behind simple paradigms and program primitives,
making programming simple and suitable for beginners. Furthermore,
the initial presentation includes information about embedded systems,
and information about programming - interrupts, events, callback
functions and event loops, etc. Event and interrupt-based
programming is the underlying programming model used in all
modern control systems. It is also related to the management of input
from remote devices as well as I/O devices connected to a controller.
Following the initial presentation, the students and the accompanying
teachers are invited to work on possible extensions of the intelligent
weather station project.
The Master Class targets students from upper secondary schools that
already have some experience in programming and knowledge in
electric circuits and schematics. Such prior knowledge would allow
them to easily understand the basic programming concepts of
Arduino.
Students should have previous experience with using variables, if-thenelse statements, loops and functions in any programming language so
that they can easily understand how the Processing language supports
those programming concepts.
2 or 3 astronomical hours

University students or teachers that have experience in teaching
introductory programming courses (preferably using the C/C++
programming language) and courses related to electrical schematics.
General understanding basic programming concepts in the Processing
language (C/C++):
•

Boolean, integer and string variables

•

local and global variables

•

records and structures

•

Boolean and arithmetic expressions
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•

functions

•

objects and methods

General understanding of event and interrupt-based programming
concepts:

KNOWLEDGE
G AI NE D AND
COMPETENCIES
DEVELOPED SCHOOL
TE ACHE RS

KNOWLEDGE
G AI NE D AND
COMPETENCIES
DEVELOPED UNIVERS I TY S TAFF
OR UNIVERSITY
STUDENTS

M ATE RI ALS
NEEDED FOR
IM PLEM ENTATI ON
OF THE ACTI VI TY

•

Interrupts

•

Timers

•

Events and call-backs

•

Event loop

Assuming that the accompanying teachers are computer science
teachers who already teach programming, they will learn the syntactic
rules of C/C++ supporting procedural programming as well as objectoriented and event and interrupt-based programming paradigms.
Accompanying teachers will also learn how to use the Arduino IDE
platform so that they could possibly later use it in their classes.
The involved university staff or university students will develop
science communication skills – in particular, skills for teaching and
explaining the functioning of Arduino devices to a less advanced
audience and demonstrate how they could be used in the development
of self-made projects for home automation.
- A whiteboard (may be useful to explain the presented code with
schematic diagrams)
- Projector and computer with Internet connection to show to the
participants the readings of the home weather station used in this
Master Class.
- Computers with Internet connection where participants can work in
groups to use and remix the presented code. Students will use the
Arduino IDE (http://www.arduino.cc) platform, which is a free
microcontroller programming environment. In general, Arduino is an
open source electronic prototyping platform based on flexible and
easy-to-use hardware and software
- Embedded systems communicate with the environment, receiving
signals from multiple sensors and interacting with it, controlling lights,
displays, motors and other devices. For example, if we want to make a
"home weather station" we will need to build a hardware solution and
write appropriate software. For the hardware we need a
microcontroller (this is actually a mini computer) and a periphery. For
the simplest home weather station, we will need sensors for
temperature, humidity, barometric pressure, dust, smoke, gas, etc.
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BRE AKDOW N OF
ACTIVITIES

This Master Class is divided into 3 parts:
1. Informative talk/Lecture: This part should take place in a lecture
room or amphitheatre of the organizing university. It starts with a
welcome and a short ice-breaker activity aiming at discussing the
previous experience of students in programming and electronics. After
that, the instructor presents the developed home weather station, the
electronic elements used in it, and the developed code.
2. Hands-on activity /Lab visit: This part should place in a computer
lab. The steps of the second part are the following:
Step 1 - The students and their accompanying teachers move to the
computer lab where the lab session will take place.
Step 2 - The students are divided into groups of 2-4 persons
(depending on the number of available computers and the number of
students).
Step 3 – The groups are invited to make certain changes in the code of
the weather station. They could either develop their own remixes or
perform specific tasks set by the organizers.
Step 4 – The university staff or students involved in the Master Class
play the role of facilitators to help the student groups develop the
selected changes/remixes.
3. Self-reflection on the part of students: This part should take place in
a lecture room or amphitheatre. Each group, as developed in part 2.
Students are in particular invited to report on the difficulties they have
faced and to share how they solved any problems. After the students’
presentations, the organizers close the meeting and provide additional
links and information for those who want to learn more on the topics
of the Master Class.

USEFUL LINKS TO
RESOURCES

https://learn.sparkfun.com/tutorials/weather-station-wirelesslyconnected-to-wunderground
http://cactus.io/projects/weather/arduino-weather-station
https://circuitdigest.com/arduino-projects
https://howtomechatronics.com/arduino-projects/
https://www.electronicshub.org/arduino-project-ideas/
https://www.hackster.io/arduino/projects?sort=trending&page=3
https://create.arduino.cc/projecthub?page=1&sort=trending

SUGGESTED
FURTHE R RE ADI NG

For more information about Arduino and introductory learning
resources
about
Arduino
programs
https://www.arduino.cc/en/Main/Education
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SOURCES USED TO
DEVELOP THE
RESOURCE

This resource is based on information about Arduino and indicative
projects that is available at:
https://www.arduino.cc/en/Main/Education
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Background knowledge sheet

EDITORS

INTRODUCTION TO
THE TOPIC

IM PORTANCE TO
D AI LY LI FE/
ECONOMY
/SOCIETY

DE TAI LE D
P RESE NTATI ON ON
THE TOPIC

Stanimir Yordanov (Technical University of Gabrovo, Bulgaria )
Most software tools available today provide powerful languages to
enable flexible customization and rich interactive content development
by end users. In this respect, knowledge of computer programming
concepts is necessary for most knowledge workers including scientists
and engineers. Consequently, many higher education departments have
included introductory programming courses in their curricula.
Furthermore, many countries extend their curricula in secondary or
even primary education to address the development of basic
programming skills. The importance of computer programming has
received even more attention through computer coding campaigns
such as the Europe Code Week. Informal learning opportunities are
also offered in many countries following the organizational approach
of coding clubs. However, in many cases, the introductory
programming courses follow the traditional approach of presenting the
features of a specific programming language one by one, along with
artificial examples and small programming exercises. An alternative,
more engaging way to promote introductory computer programming
knowledge is through the use of meaningful examples and coding
projects such as embedded system and devices. This is the approach
taken in this Master Class. By following this Master Class, the
participating students will have the opportunity to understand the
basic methods for designing, programming and building embedded
systems.
Arduino has recently been introduced in vocational training curricula
as well as in upper secondary education in many European countries.
Consequently, the popularity of the Arduino based systems is growing
in education. This trend resonates with the use of Arduino modules as
an embedded system in many platforms and applications as well as
with its growing popularity in industrial and home automation and
Internet of Things (IoT).
Definition of terms
The following terms need to be defined during the activity:
- Arduino systems
Arduino is an open-source microcontroller with an easy-to-use
hardware and software (a programming language and an Integrated
Development Environment – the so-called IDE).
Arduino controllers are relatively inexpensive, and the Integrated
Development Environment is a free program running on Windows,
Mac OS X, and Linux. Most often, Arduino boards are based on the
Atmel AVR architecture (ATmega328 microcontroller with an 8-bit
RISC processor core). Arduino’s programming language is called
The European Commission's support for the production of this publication does not
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"Processing” and it is specifically designed to make programming easy
and simple for beginners. It overcomes the complexity of traditional
programming for embedded systems and microcontrollers with the
help of simple paradigms and software primitives. Instead of
programming in the C language, which is much more complex and
more difficult, users write programs in the "Processing" language, and
then the Integrated Development Environment (IDE) transfers
(converts) the program to the C language and uploads it into the
controller via a standard USB cable.
The Arduino board can be expanded by mounting additional modules,
thus expanding its functionality. For example, an Ethernet module
may be added in order to use a TCP / IP based network
communication, or a GSM module may be mounted to communicate
over the mobile network.
- Event and interrupt-based programming
Events and interrupts are signals that indicate the occurrence of
certain conditions in the system or executed program that call for the
intervention of the processor. These occurrences cause the processor
to terminate the current task and to hand over the processing to
another special procedure or task. Interruptions can occur randomly.
They can be caused by hardware (external) and software. External
interruptions are generated from a peripheral device that requires a
service. Software interrupts are caused by the program invoking a
particular instruction or by the processor itself.
Events on the other hand are internal processor occurrences that
indicate errors in the execution of an instruction: division by zero,
violation of security rules, etc. The capability of the processor to
respond is embedded in the command loop, and events that require
processor attention must send signals called interrupt requests. Signals
sending interrupt requests must be reported to the central control unit.
- Embedded systems
Embedded systems are an integral part of our daily lives. They are
widely used in the fields of telecommunications, consumer electronics,
transportation and industry. They combine hardware and software
built into a device. Examples of embedded systems are the TV remote
control or the air conditioning remote control, cameras, MP3 players,
modern stoves, washing machines, TVs and all kinds of consumer
electronics. They are specialized computer systems and, like any
computer, they have a microprocessor, memory and peripheral devices
that are all controlled by software. Like any computer, embedded
systems are programmed by a software engineers who writes code.
Such specialists are called ‘embedded software engineers’.
Embedded systems are generally assumed to be electronic digital
systems programmed to perform certain functions in real time.
Depending on their purpose, they are characterized by different
complexity - from elementary (with one microcontroller chip) to
complex systems consisting of multiple devices, peripheral and
The European Commission's support for the production of this publication does not
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network modules, mounted on a common chassis or even integrated
into a single cabinet (case). A modern trend in their production is the
desire to minimize size, mass, energy consumption and cost, while at
the same time increasing system reliability and functionality.
It is important to facilitate the first steps of secondary students in
programming and in developing electronic devices. It is important to
do this in an engaging way that will help students understand the basic
features and characteristics of these systems. The approach adopted in
this Master Class is to use simple devices and systems that can be
explored to understand the process of programming and building
embedded system using an Arduino IDE.
The code of the home weather station used in this Master Class is
available online from:
http://aiut.tugab.bg/Project/meteostation/meteostation.rar
From this link it is also possible to download the code in any web
browser. Based on the above initial code, many possible extensions
can be developed. Indicative extensions will be suggested to the
participating students.
The code demonstrates most of the basic features of Arduino
programming:
• Installing and using libraries
• Using comments in program code.
• Definition of functions as follows:
void setup () - this function is executed first when the controller is
turned on. In it the programmer records the code initializing the
peripheral terminals of the controller.
void loop () - this function starts immediately after the setup ()
function has finished. It records the actual control program code.
Once the code has been completed, the function is automatically
restarted.
The code performing the definitions of the setup and loop in C / C
++ is as follows:
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pinMode () - this fuse initializes a pin as an input or output
digitalRead () - This function reads the state of a digital input
digitalWrite () - This function sets the status of a digital output
analogRead () - This function reads the state of an analogue input
digitalWrite () - This function sets the status of an analogue output
(PWM)
Serial.begin (115200) - Serial channel initialization
Serial.print () - Sends data to a computer on the serial interface
Serial.read () - Reads data obtained from a computer on the serial
interface
These are some of the standard features used in the program. This
section will also show the user-defined functions that perform certain
tasks. For example:
void displayWEB () function - realizing a local WEB page with the
readings of the meteorological page.
void parserUDP () - receiving UDP protocol parameters from a
computer or phone
bool sendToMySQL () - sends the measured data to a remote MySQL
server.
The activity should also demonstrate the use of timers and
interruptions.
Instructors can demonstrate one of the following Arduino projects
and discuss with students their implementation. They can play the
videos in these projects or show a developed model:
•

Robot: Vorpal the Hexapod
The European Commission's support for the production of this publication does not
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https://create.arduino.cc/projecthub/vorpal-robotics-llc/robotvorpal-the-hexapod-4f4e90?ref=tag&ref_id=fun&offset=8
•

Control the TV with the power of thought and Arduino

http://www.tinkernut.com/portfolio/homemade-mind-controlled-tvremote/#lightbox[9305]/8/
•

LED cube

https://youtu.be/tqWAC4hu7nk
https://youtu.be/2BlVUKW5hL0
https://www.makeuseof.com/tag/how-to-make-a-pulsating-arduinoled-cube-that-looks-like-it-came-from-the-future/
•

Arduino Radar Project

https://howtomechatronics.com/projects/arduino-radar-project/
•

Pixel Chaser Game © GPL3+

https://create.arduino.cc/projecthub/unexpectedmaker/pixel-chasergame-5929cf?ref=tag&ref_id=fun&offset=19
•

TOP 10 Arduino Projects of All Time | 2018

https://youtu.be/-p_8u_0GNZE
https://youtu.be/0XTcJ5-0u00
For further details and support, see Annex 1: Knowledge Resource.
SCIENCE
COMMUNICATION
GUI D ANCE TO
INSTRUCTORS

All the details regarding the home weather station code that are
described in the ‘Detailed presentation’ field above should be
presented appropriately during the introductory session (informative
talk) from a perspective that emphasizes the way the code is executed.
Furthermore, the presenter should first ask the students about their
prior programming knowledge in order to link the new knowledge
with what the students already know. For example, if the students have
experience in programming with C/C++, the presenter should
describe the presented code by making analogies with C/C++.
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Lecture planning sheet

GO AL

SETTING

The goal of the informative talk is to encourage students to learn
about the functioning and programming of embedded systems, and
to understand the code of the weather station that is used in this
Master Class. The students will be invited to revise this code in the
second part of the Master Class (the hands-on activity).
The ideal number of participating students depends on the second
part of the Master class that will be implemented in a computer lab.
During that second part, the students will be organized in groups.
There are no special requirements for the organization of space
during the lecture.

LOCATION FOR
THE
TALK/ LECTURE
POSSIBILE
INVOLVEMENT OF
UNIVERSITY
STUDENTS IN THE
ACTIVITY

TIMING & RUNDOWN

Lecture room or amphitheatre.
University students may undertake the responsibility to present the
code while the university staff could coordinate the activity and the
discussion with the students. Their role is especially important in the
beginning of the activity when the secondary students are invited to
report on their previous knowledge on computer programming.
Phase
no.

Description of phase

Time
allocated

1

Welcome note and explanation of the aim of the 2 min
Master Class

2

Ice breaker

3 min

For example, the instructor could invite the students to work
in pairs to find 2-3 things which distinguish programs running
in real-time mode from others; how to use 5V peripheral
devices to ESP series controllers that work at 3.3V, etc.
3

Introduction to embedded systems

10 min

4

Presentation of the home weather station

5 min

Volunteers are asked to use an android application to access
the readings of the weather station.
5

The participating students are invited to answer 10 min
the following questions:
-

How does this system work?

-

What happens when you press the
‘Restart’ button or tap a temperature
sensor?

-

How could you develop this system by
programming or using new hardware

The European Commission's support for the production of this publication does not
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sensors that you already know?
6

Presentation of the weather station code

25 min

See the details presented in the ‘Background Knowledge
Sheet’). Volunteer HEI students may undertake the role of
presenter here.
7

Closing and moving to the computer lab

5 min

The instructor briefly presents what will follow and what kind
of remixes the students will be facilitated to do in their activity
in the computer lab.
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Hands-on activity/experiment planning sheet

GO AL

SETTING

LOC ATI ON AND
EQUIPMENT

POSSIBILE
INVOLVEMENT OF
UNIVERSITY
STUDENTS IN THE
ACTIVITY

CONTENT OF THE
H ANDS -ON
ACTIVITY

TIMING & RUNDOWN OF THE
H ANDS -ON
ACTIVITY

The goal of the hands-on activity is to facilitate the students to develop
their own version of the weather station by implementing possible
revisions and extensions to the code presented during the first part of
the Master Class.
The activity takes place in a computer lab where the students work in
groups of 2-4 persons per group, depending on the available space.
The hands-on part of the Master should take place in a computer lab
at the university. The computers should have an active Internet
connection and the Arduino IDE installed.
The activity is designed to involve university students as facilitators.
Each facilitator should support at most 2 groups of students. In case
of lack of volunteers, this can be done by university staff. However,
the involvement of university students is highly desirable as it will help
the secondary school students feel more comfortable to discuss
additional issues beyond programming (e.g. employment options,
internships in industry, student life, etc.).
During this activity, the secondary school students will be invited to
modify the initially presented code of the home weather station. They
will also be given several ideas for extensions that they can implement.
However, they may also choose to develop their own ideas.
Phase
no.

Description of phase

Time
allocated

1

Organization of groups so that in each group
there is a balance between students that have
previous experience in programming and
students that do not have strong programming
skills.

2-5 min.

2

Brief introduction to the Arduino IDE interface

2-5 min.

3

Presentation of possible extensions

5-10 min.

4

Students work in groups to develop their
extensions

20-40
min

Volunteering university students act as facilitators
5

Feedback and self-reflection:
The groups present in turn their creations and report
on the problems they have confronted and the
solutions they have found. This final reflection phase
can happen back in the lecture room or amphitheatre

30-40
min
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that was used for the initial informative talk.
6

Conclusions and farewell

5 min.
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Annex I: Knowledge Resource

Arduino Programming and building of embedded system
Editor: Stanimir Yordanov, Technical University of Gabrovo, Bulgaria
EMBEDDED SYSTEMS

An embedded system is an electronic device that is built into a mechanical or electrical system in
order to extend its functionality by adding new features.
The term "embedded" indicates that the system is an integral part of another larger system or an
integral part of the controlled device. An embedded system may be composed of several smaller
embedded systems.
Oftentimes, the embedded system is a component in any larger system. For example, modern
cars contain many embedded systems. One of these systems controls the vehicle's fuel system,
another controls emissions, and a third displays information on the dashboard. In some cases,
these embedded systems are connected to some kind of communication network.
The first embedded systems appeared after 1971. This is the year when Intel introduced the
world's first microprocessor - the Intel 4004. The emergence of microprocessors resulted in the
rapid development of embedded systems in various areas of human activity, such as space
probes, computerized traffic lights, aircraft flight control systems, bread makers, microwave
ovens, television sets, stereo systems, remote controls, cash registers, credit card readers,
navigation system, etc.
The principle of operation of an embedded system is the follows:
-the system receives information from sensors that monitor the values of certain variables
-based on the monitoring results and the in-built algorithm, the system controls various actuators
-actuators control the mechanical or electrical system.
Unlike software designed for general-purpose computers, embedded software cannot normally be
run on other embedded systems without significant modification. This is mainly due to the
diversity of hardware. The hardware in each embedded system is specifically tailored to the
application for which it was designed in order to maintain low production and operating costs.
All embedded systems contain processor and software. Where software is available, it is also
necessary to ensure that there is a place to store executable code (FLASH and ROM memories),
as well as to temporarily store data during runtime (RAM memory). If only a small amount of
memory is required, it may be contained in the same chip as the processor; otherwise, external
memory chips are required.
All embedded systems contain inputs and outputs. For example, in a microwave oven the inputs
are the buttons on the front panel and the temperature probe, and the outputs are the device
display and the microwave transmitter. The outputs of an embedded system are almost always a
function of its inputs and several other factors (time elapsed, current temperature, etc.). Typical
inputs to the system are sensors and probes, communication signals or control knobs and
buttons. Typical outputs are displays, communication signals, or changes in physical values.
Figure 1 represents a generic diagram of an embedded system. The main elements of an
embedded system are:
The European Commission's support for the production of this publication does not
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The computing core: It is most often based on a microcontroller, but is can also be based
on a microprocessor, a digital signal processor (DSP), a field-programmable gate array (FPGA)
device or an application-specific integrated circuit (ASIC).

The computing core: It is most often based on a microcontroller, but is can also be based
on a microprocessor, a digital signal processor (DSP), a field-programmable gate array (FPGA)
device or an application-specific integrated circuit (ASIC).

Embedded System

Processor

Outputs

Inputs

RAM
memory

FLASH (ROM)
memory


Memory: it is used to process and store data. Memory also stores the program code.
Depending on the type, the memory is divided into energy-dependent, volatile memory typesRAM, SRAM, DRAM, DDRAM and energy-independent, non-volatile memory types - ROM,
PROM, EPROM, EEPROM, Flash. Each type of memory has its own specifics and application.
Volatile memory is used for data processing. Non-volatile memory is used for storing the
program, as well as storing data that must be retained after the embedded system’s power supply
is disconnected.

Analogue signal processing schemes: These schemes are used to pre-process the signals
coming from the sensors. They are also used for scaling signals, filtering useful signal from
unwanted noise, etc.

Analogue-to-digital and digital-to-analogue circuits. Analogue-to-digital conversion
(ADC) circuits are necessary to process analogue signals from a microcontroller or from another
digital circuit. ADC circuits convert analogue signal voltages into digital formats and they are
mainly used to collect data from sensors that measure values monitored and controlled by the
embedded system. Digital-to-analogue conversion (DAC) schemes, on the other hand, allow the
values of certain variables or parameters of the embedded system software to be converted into
analogue signals, which in turn can be used to control actuators.

Digital signals in embedded systems. As in most electronic devices, in embedded systems
the digital signals sent to the microcontroller and other integrated circuits most often have a
The European Commission's support for the production of this publication does not
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voltage level of 3.3V or 5V. However, when it is necessary to control external devices, signals
with higher voltage levels are required. In embedded systems, such voltage levels do not cause
problems as electronic components are usually protected, most commonly by galvanic
isolation between low and high voltage signals.

Timers: a timer can be programmed as a counter, which can have an additional
configurable prescaler of its input clock, and the clock source can be selected by the software.
Larger microcontrollers have several timers that can have different bit rates, such as 8- and 16-bit
timers.

Communication interfaces for exchanging data: modern embedded devices contain many
integrated circuits such as memories, analogue-to-digital and digital-to-analogue converters,
sensors in integrated design, etc. These circuits exchange data using digital interfaces, the most
common of which are SPI, I2C and UART interfaces. Built-in devices may also be able to
exchange data with a personal computer using USB, Ethernet, Bluetooth and WiFi interfaces.

Visualization of information: for user convenience, an embedded device usually includes
an indicator that can take different forms, from ordinary LEDs to modern touch-screen displays.
The indicator enables communication with the user and it enables the user to visualize and
change particular parameters in the software program that controls the operation of the
embedded device.

Power supply: the power supply is an extremely important part of an embedded device.
The power supply can be connected to the main electric network or it can be independent of it is
it is based on batteries or a photovoltaic panel. Regardless of the power source, the voltage
regulators in embedded systems ensure that the electronic circuits are supplied appropriate
voltage.

Software: the embedded device would not be able to perform its function without
appropriate software. Therefore, it is important that the operation algorithm of the device is
properly implemented as a software program. Either assembly language (low-level programming
language) or, more commonly, high-level programming language can be used to develop the
software. Depending on the type of embedded system, software development is performed
without the use of an operating system or using an operating system. When an operating system
is used, it is most often a real-time RTOS (Real Time Operating System), characterized by high
reliability and a predictable response time. Embedded software is also known as “firmware”
because it is written to non-volatile memory and ideally will not be modified over the whole
course of system operation, which can last for decades. In many modern systems, programs are
stored in flash memory and can be replaced when modernization is necessary, provided that
security protocols are followed. This enables the modernization of existing and operational
embedded systems but also creates prerequisites for abuse. Among the most popular Operating
Systems (OSs) for embedded systems are QNX4 RIOS, Embedded Linux, Free RTOS, Windows
CE, etc.
The development of embedded systems is directly related to the development of microprocessor
systems. The emergence of novel, high-performance processors and microcontrollers has a great
influence on modern embedded systems that are used in household appliances and a variety of
other devices used in all human activities. The widespread use of the Internet and the
opportunities created by Internet Protocols to remotely connect different devices is a key further
step in the development of embedded systems.
Trends in embedded systems development suggest that these systems will become ever more
connected to each other through the global network and will increasingly be able to provide
services through the Internet. Technologies that underpin the Internet of Things (IoT) are the
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high-speed Ethernet or WiFi networks. Using these technologies, devices are able to access
shared cloud services, where they can store in databases any information necessary for their
operation and read this information from the cloud.
Another emerging trend is the use of Artificial Intelligence. Thanks to Artificial Intelligence,
embedded devices can perform functions that were, until recently, only performed by people.
Through Artificial Intelligence and access to information on the Internet, embedded systems can
perform analyses and autonomously make decisions in during their operation.
THE ARDUI NO PL ATFORM

Arduino is an open-source programmable hardware platform for handling multiple physical
objects. It consists of a microcontroller board and a special Integrated Development
Environment (the Arduino IDE) that is used to develop and code microcontroller software.
Arduino can be used to develop interactive systems controlled by various sensors and switches.
These systems, in turn, can control various indicators, motors and other devices. Arduino
projects can be independent or they can interact with software running on a personal computer
(e.g. Flash, Processing, MaxMSP applications). The platform consists of hardware and software,
both of which are flexible and easy to use.
A simplified version of C++ known as Wiring (http://wiring.org.co/) is used for Arduino
programming. Applications can be developed either by using the free Arduino IDE
(https://www.arduino.cc/en/Main/Software) or by using any C / C ++ IDE. The Arduino IDE
software is easy to understand and simple to use by beginners, while also being flexible enough
for advanced users. It is based on the Processing language and IDE (https://processing.org),
which makes it easy to use in education and training. High school and university students that
have learned how to code in the Processing IDE can easily master Arduino.
The Arduino software is open source, so experienced developers can modify and supplement it.
Arduino language capabilities can also be expanded with C ++ libraries.
Arduino consists of an 8-bit Atmel AVR microcontroller and optional components. An
important aspect of the Arduino platform is the availability of standard connectors that allow
users to connect the CPU board to variety of different interchangeable modules called “shields”.
There are various interchangeable shields available on the market that can be mounted on an
Arduino. Some shields communicate with the Arduino directly through different pin ports.
Thanks to the I2C bus, several shields can be mounted and used at the same time.
Most Arduino platforms operate at 5V operating voltage and feature 14 digital I/O
(Input/Output) ports, 6 analogue inputs, a 16 MHz crystal resonator, four LEDs, a USB
connector, a power connector, a reset button, and an ICSP (in-circuit serial programming)
connector. The Arduino can connect to a computer through a USB cable.
The Arduino microcontroller comes with a bootloader that makes it easy to load programs into
the device's flash memory. This makes using Arduino easy as it allows programming to be
performed using a simple computer.
There are various versions of the Arduino platform - Arduino Mega, Arduino Uno, Arduino
Nano, Arduino Mini, Arduino Ethernet, Arduino BT, Arduino Leonardo, Arduino Micro,
Arduino Due (http://arduino.cc/).
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A number of compatible sensors and actuators have been developed for Arduino. They are used
by reading from or writing directly into Arduino pins. Open source libraries have been developed
for many sensors.
P ROGR AM M ING OF AR DUI NO M ODULES

In terms of programming, all of the boards are programmed in the Arduino IDE, and no
additional components or devices are needed to operate them. Everything is inbuilt into a
development board that makes Arduino devices easy to work with. Arduino enjoys great
community support around the world and a great number of libraries and examples of how to
use the platform already exit. The official site provides detailed information about Arduino, as
well as many sample projects for operating Arduino with peripherals (sensors, actuators, displays,
Arduino Shields, etc.).
As already mentioned above, Arduino developers have also created an Integrated Development
Environment (IDE) that is simple enough to help beginner programmers and powerful enough
to allow experienced users to build more complex projects.
To install the Arduino programming environment, visit the company website
https://www.arduino.cc/en/Main/Software and open a window for downloading the IDE
software.

From the page showed above, the user has to choose the Operating System (OS) on which the
IDE has to be installed in. Clicking on the link with the correct OS will initiate the download of
the installation file.
Once the installation file is downloaded, it must be run. After the arduino-1.6.12-windows.hehe
file is run, a standard license message will appear initially, which must be accepted by pressing the
"I agree" button.
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A new window will pop up, prompting the user to select the desired actions that the installer has
to perform. It is very important to select the "Install USB driver" option as this ensures that the
USB port will be properly configured to work with the Arduino board.

In the next step, the standard window for selecting a directory for installing the IDE will be
displayed. In our example, the default directory is C: \ Program Files (x86) \ Arduino \.
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Once the "Install" button is pressed, the installation of the program will begin. As the installation
progresses, a window will appear asking for permission to install the Arduino USB Driver. In
order to ensure that the USB port will work properly with Arduino, the "Install" option must be
selected.

The installation will complete after this step, and a pop-up window will confirm this. To finish
the installation, the user should press the "Close" button, after which the program can be
launched.
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The next step is to create a new project in the Arduino IDE. The procedure is the same for
Windows and Linux based systems. When the IDE starts, the main window will open. It will
contain two functions: void setup () and void loop (). The generated code will look like this:

Including additional libraries will not be required for this project, but it is important to know how
to include libraries in a project created in the Arduino IDE. This can be done in two ways. One
way is to include external libraries created by someone else. Libraries should be archived as a
RAR file, which has to be included in the Arduino environment through Sketch-> Include
Library-> Add .ZIP Library.
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Another way to include libraries is to create a new folder in the root directory of the Arduino
IDE, which in our example, it is C: \ Program Files (x86) \ Arduino. From there the libraries
folder must be selected. Inside this folder are the libraries divided into different folders.
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When the user starts Arduino for the first time, the IDE will open a window that is ready for
writing a program. When writing a program in the Arduino environment it is important to note
two important functions.
The first important function is void setup (), and the other is void loop (). The setup () function
specifies the role that each controller pin will play and specifies the libraries that will be used.
This part of the program is executed only once. It is followed by the loop () function, which is
repeatedly executed and it must contain within it the actual program for operating the controller.
Once the program is written and ready for compilation, it first needs to be saved to the user’s
computer under a unique name. This is done by selecting the Save as command from the File
menu or by pressing the keyboard shortcut Ctrl + Shift + S. Once saved, the program must be
compiled. This can be done in two ways: one way is to compile without uploading the program
onto the controller and the other is to compile and upload the program into the controller
memory. To compile the program without uploading it onto the controller, the Verify / Compile
option must be selected from the Sketch menu or with the keyboard shortcut Ctrl + R. An
alternative way is to simply click the checkmark button just below the menu bar. The other
compilation method is compilation with uploading into the memory of the controller. This can
be done again via the Sketch menu but this time the Upload option must be selected. It can also
be done by pressing the button depicting an arrow pointing to the right, which is directly next to
the checkmark button, or by pressing the keyboard shortcut Ctrl + U.

For example, we can upload a sample program from the Arduino system. The Arduino
programming environment comes with many examples and we can use one of these programs to
show how to compile and upload a program.
To open a program from the examples available in the IDE, the user has to select File->
Examples-> Basics-> Fade from the menu. This will open a new window in which this program
will be loaded. The user should only compile and upload the program into the controller's
memory.

The European Commission's support for the production of this publication does not
constitute an endorsement of the contents, which reflect the views only of the authors, and the
Commission cannot be held responsible for any use which may be made of the information
contained therein.

26

To upload the program onto the controller, we first need to connect the Arduino controller to
the IDE. This is done by selecting Tools-> Port from the menu. When the user clicks on the
Port option, another submenu will open in which the user must select the desired port to which
the controller is connected.

Once the controller is connected, the program must be uploaded into its memory. There are two
ways to upload the program. One is by pressing the arrow button, and the other is from the
Sketch-> Upload menu (or by pressing Ctrl + U).
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Once the program has been compiled and uploaded into the controller's memory, “Done
uploading” is displayed below in the message box. This means that the program is fully loaded
into the controller and will run almost immediately.
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Annex II: Model hands-on activity sheet
Development of Esp8266 Microcontroller Home-Made Weather Station
Editor: Stanimir Yordanov, Technical University of Gabrovo, Bulgaria
INTRODUCTION

Over the last decade, we have witnessed intense changes in the behavior of climate processes.
New records are set on fallen rain and atypically high temperatures at different points on Earth
were measured. More and more devastating storms, droughts in many places around the world,
as well as floods as a result of heavy rainfall, are only some of the results of climate change.
According to some observers, it is the result of human activity, while according to others, this is
part of natural cycles on our planet. Only time will show who is right in their claims. But in any
case, atypical and uncharacteristic phenomena increase their frequency and strength and this
directly affects people's lives. It is for this reason that accurate and timely reporting of weather
indicators is extremely important in many aspects of our lives, especially those related to the
microclimate at home or at the workplace.
The weather station is mainly designed for monitoring current temperature, humidity and
atmospheric pressure, dustiness and illumination monitoring. We will develop our weather station
based on ESP8266 and programming in the Arduino IDE environment, but the data will be
displayed on the mobile phone and recorded on a remote server.
Main environmental parameters are:
•
Temperature - characterizes the average kinetic energy of the particles of a macroscopic
system in a state of thermodynamic equilibrium
•

Air humidity –the amount of water vapor in the air.

•
Atmospheric pressure - the pressure exerted by the atmosphere on a unit of earth's
surface
•

Amount of rainfall – the amount of water falling on the ground in the form of rainfall

•
Sun exposure – a physical quantity describing the time the sun shines directly during a
certain time interval
•
Airborne dust - entry of new chemical, mechanical or biological substances that are
uncharacteristic of the air
GUI DELI NES FOR DEVEL OPI NG A HOM E -M AD E W E ATHE R S TATI ON

Appropriate sensors, a microcontroller and management software are required for the
development of a weather station. There are many platforms that can be used to build the station,
but the cheapest and easiest to implement is the Arduino controller application and its
compatible sensors. These sensors are precise enough to capture meteorological data. A 32-bit
ESP8266 processor will be used in the present paper to develop the weather station (Figure 2).
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Figure 2: Description of the Node MCU ESP8266 microcontroller

The NodeMCU is built with ESP8266 based WiFi module ESP-12E. There are 10 GPIO ports,
4MB Flash, two buttons, micro USB connector and built-in PCB antenna. The GPIO ports can
also be used as PWM, 1-Wire and I2C. It has a 48mm x 25mm size, 4 mounting holes, and a
2.54mm (2.54mm) gap between them compatible with Breadboard. It can be powered by a
voltage of USB 5V or by an external power supply of 5V - 12V, connected to a Vin pin. The
operating voltage of the GPIO ports is 3.3V. When connecting to devices and microcontrollers
operating at 5V, it is necessary to use a converter at logical levels. The controller has a Lua
firmware and can be programmed with the Arduino IDE thanks to the CP2102 USB-port serial
converter.
The following meteorological parameters can be monitored with the weather station:
temperature, humidity, dust, atmospheric pressure, altitude, rain, sunshine.
M E AS UREM ENT OF TEM PE R ATURE AND HUM I DI TY

The DHT22 sensor is used to measure temperature and humidity.

Figure 3: Connecting the DHT22 to NodeMCU

The Humidity and Temperature Sensor - DHT22 - measures temperature ranging from - 40° to
80° C, and relative humidity in the range 0% - 99%. It has a pre-calibrated digital output and is
notable for its reliability and stability. The sensor is mounted on a 40mm x 15.4mm board. It has
a triple interface connector and a mounting hole. It is powered by and operates at 3.3V - 5V
voltage.
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The scheme of the sensor connection to the controller is given in Figure 3. In order to read the
data, it is necessary to install the library.
The code for reading the temperature and relative humidity is as follows:
#include <DHT.h>
#define DHTPIN 13// D7
#define DHTTYPE DHT22
// Sensor initialization
dht.begin();
// Measurement of the temperature and
// relative humidity
float h = dht.readHumidity();
float t = dht.readTemperature();
B AROM E TRI C P RESSURE M E AS UREM ENT

Atmospheric pressure is one of the most important meteorological elements. Torricelli's tubes
were the first instrument used to measure it, and therefore atmospheric pressure is measured in
millimetres of mercury pillar (mmHg). Later, the unit millibar /mb, mbar/ was introduced. When
measuring atmospheric pressure in meteorology, the following types of barometers are usually
used:


liquid barometers /mercury/, operating on hydrostatic basis;



deformation barometers /aneroid/, based on the properties of solid bodies;



gas barometers, based on the properties of gas;


hypsothermometers or thermobarometers, based on the relationship between boiling
point of liquids and external pressure.
In this guide we use the BMP180 sensor manufactured by Bosch. It is designed to connect
directly to a microcontroller or a mobile device via an I2C interface. Atmospheric pressure and
temperature data are compensated by calibration coefficients in the E2PROM sensor memory.
The BMP180 consists of a piezo-resistive element, an analogue digital converter and a control
device with E2PROM memory and a serial I2C interface. The sensor produces uncompensated
pressure and temperature data, so in the E2PROM memory there are 176 bits of calibration
coefficients to compensate for temperature dependence and other sensor parameters. The
microcontroller sends a request for measuring pressure or temperature.

Figure 4: Connecting the BMP180 sensor to NodeMCU
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The SFE_BMP180 library is used to measure atmospheric pressure. Here is an example of how
to use it:
#include <SFE_BMP180.h>
#include <Wire.h>
// declaration of pressure measurement object
SFE_BMP180 pressure;
// Initialize the measurement
pressure.begin() ;
// Pressure measurement
char status;
double T,P,p0,a;
status = pressure.startPressure(3);
status = pressure.getPressure(P,T);
p0 = pressure.sealevel(P,ALTITUDE);
a
= pressure.altitude(P,p0);
M E AS URING THE RAI NF ALL LEVE L

In meteorology the word rain is defined as both the fallen water and the water condensed on the
earth’s surface and objects. In either case, the water may be in a liquid or solid state. All rainfall is
due to the same reason - the low temperature of the earth’s surface and the lowest layers of air.
The following rainfall characteristics are used in meteorology:

Quantity – the thickness of the water layer (in mm of water column) that can be formed
over a horizontal impermeable surface. This unit of quantity is identical to the litre per square
meter (l / m2) unit which is used in practice.


Intensity – rainfall per unit of time (mm/h)



Duration



Type of rainfall

All kinds of rainfall can be monitored by weather stations. In the case of rainfall originating in
clouds, duration and amount of precipitation for a certain period of time are being measured. For
other types of rainfall (dew, frost, fog) only the time of occurrence is measured.
The rain sensor module MH-RD Flying Fish is an easy tool for detecting rain. It can be used as a
contact when the rain falls on it, as well as to measure the intensity of the falling rain. The
module consists of two boards, one on which the water falls, and another that performs the
measurement, both separated from each other for greater reliability, a LED lamp and a sensitivity
adjustment potentiometer.

Figure 5: Connecting the MH-RD Flying Fish to NodeMCU
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const int sensorMin = 0;
const int sensorMax = 1024;
int sensorReading = analogRead(A0);
// read the sensor on analog A0:
int sensorReading = analogRead(A0);
// map the sensor range (four options):
// ex: 'long int map(long int, long int, long int, long int, long int)'
int range = map(sensorReading, sensorMin, sensorMax, 0, 3);
M E AS UREM ENT OF SUNLI GHT

Solar radiation in weather stations is measured by sunshine duration and intensity of light
indicators. The BH1750FVI Sensor is used in the present paper to monitor sunshine. The
BH1750FVI sensor is a digital ambient light sensor that uses an I2C interface. It reports a wide
range of illuminance levels (1 - 65535 lx). It converts the light readings to a digital code. It
consumes a small amount of electricity. It is not affected by the light source (for example:
fluorescent lamp, mercury lamp, halogen lamp, LED, sunlight), and the influence of infrared light
is very small.

Figure 6: connecting the BH1750 sensor to NodeMCU
The BH1750 library is used in Arduino applications:
#include <Wire.h>
#include <BH1750.h>
BH1750 lightMeter; // Declaring the sensor
lightMeter.begin();// Sensor initialization
uint16_t lux = lightMeter.readLightLevel(); // Measurement
FI NE P ARTI CLE RE ADI N G

Fine dust particles are microscopic solid or liquid substances airborne in the earth’s atmosphere.
Sources of dust particles can be naturally occurring or artificial. Major sources are flowers (pollen
sources), fires, diesel engines, mining, construction (sand and metals) and natural sandstorms.
The DSM501A sensor is used to read fine particles.
A wide-pulse modulation (WPM) signal occurs at the output of the sensor. The size of the
detected particles that can be detected is minimum 0.7 μm. The sensor determined the number of
particles using an optical technology.
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Figure 7: Connecting DSM501 to NodeMCU

Measurement of particulate matter is done with the following code:
int pin = 15;
unsigned long duration;
unsigned long starttime;
unsigned long endtime;
unsigned long sampletime_ms = 30000;
unsigned long lowpulseoccupancy = 0;
float ratio = 0;
float concentration = 0;
pinMode(15,INPUT);
starttime = millis()
duration = pulseIn(pin, LOW);
lowpulseoccupancy += duration;
endtime = millis();
ratio = (lowpulseoccupancy-endtime+starttime + sampletime_ms)/(sampletime_ms*10.0);
concentration = 1.1*pow(ratio,3)-3.8*pow(ratio,2)+520*ratio+0.62;
INTERNET CONNECTION

The microcontroller allows connection to the Internet through its built-in wireless connection
module - ESP8266. It can be configured as a server and can be accessed through the page it
generates. This page is used to display the measurement data. For this purpose, a dynamic Web
page shown in Figure 8 is built into the controller.
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Figure 8: Web page
D AT AB AS E CONNE CTION

The controller processes and sends a request to a database, creating a table containing ten fields,
which respectively record the IP address of the device that sends the information, the time and
date of the recording, and the measured parameters. The recording is updated every minute. The
saved data can be used to generate statistics, trend calls, forecasts, etc.

Figure 9: Database
S UMM ARY AND TES T

The parameters measured by the device are temperature, humidity, barometric pressure, altitude,
rainfall, illuminance and fine particle count. They can be monitored through the system console,
recorded in a database, and accessed remotely.
The opportunity to measure atmospheric parameters with the weather station and to monitor and
analyse the results remotely allows for prognosis of changes in these parameters. The system is
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fully automated and an algorithm is developed for the conversion of the measured information
into physical quantities.
Test questions
1.

What is the „weather station“?

2.

What are the basic environmental parameters?

3.

What is Arduino?

4.

What are the characteristics of the ESP8266 controller?

5.

Which sensors are used in the developed home-made weather station?

6.

How is the connection to the weather station achieved?
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Annex III: Co-Creation

University Students
Selection
The following university students can be involved in the design and delivery of the activity:
-

Students of Computer Science, Mechatronics or Engineering, in any year of studies, as
long as they are knowledgeable in programming, and have practical experience with
Arduino or embedded systems.
Students should be selected by the faculty member responsible for the activity and
should have worked with this faculty member before (in class or in educational outreach
activities).

Selected students should stand out for their science communication skills rather than their
excellence and academic achievement per se.
Role (in order of relevance)

Guidance

Pedagogical co-designers of learning, teaching
and assessment; facilitators in hands-on and
lab experiments

The selected university students:
- should work together with high school
students during the practical activity and help
them use Arduino to develop the weather
station
- should participate in the assessment of
student performance during the course and in
the evaluation of the effectiveness of the
training
-should also be actively engaged in the selfreflection phase, staying with the student team
in which they worked.

Mentors of SE VET students

The selected university students can be asked
to share their contacts with bright or
motivated high school students who may want
to learn more about Programming or Robotics.
The possibility of involving high school
students in teams working on university
projects or contests in the field of Robotics,
Mechatronics of the development of
embedded systems should be explored.

Consultants in planning and designing the
learning and teaching process

The selected university students should be fully
engaged in the design of the hands-on activity
in order to ensure that the tasks would be
manageable for younger students without prior
experience with programming.
Students can be given the task to prepare the
Power Point presentation for the activity, as
well as any handouts and supporting materials.
They should, however, do this on the basis of
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clear instructions from the faculty member
who will lead the course.
Co-researchers contributing to subject-based
research

The selected university students can be asked
to design detailed guidelines for the
development of the home weather station
during the practical activity. They should be
instructed to keep the level of difficulty close
to the skills and knowledge of high school
students.

High School Teachers (supporting role is suitable for teachers in Computer Science or
Physics)
Consultants in planning and designing the
learning and teaching process

The accompanying teachers should have the
leading role in selecting trainees from among
the students.
They should be approached in advance and
consulted about the relevance of the presented
examples and the level of difficulty of the
theoretical presentation (in view of the
intended group of trainees). Special attention
should be paid to the selection of manageable
practical tasks and the avoidance of tasks that
have no relevance to the compulsory
curriculum.
Teachers should be consulted about the best
way to draw parallels and to link the content of
the course to the compulsory curriculum.

Pedagogical co-designers of learning, teaching
and assessment; facilitators in hands-on and
lab experiments

The accompanying teachers should work
together with high school students during the
practical activity in order to help them develop
the embedded system of the weather station,
as well as provide clarification to those that
have failed to understand the presented
material or apply it in practice.
Most teachers would be in position in which
they themselves will use Arduino for a
complex embedded systems project for the
first time. They should be given the chance to
learn themselves.
High School teachers should be the primary
source of feedback about the effectiveness of
the training. They will also be in the best
position to assess the performance of their
students.
Teachers should play a central role in
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maintaining discipline during the activity.
University-high school partnerships
This course in particular would be a suitable addition to study programs in secondary schools
with a profile in Computer Science, Mathematics, or the Natural Sciences. It can be the beginning
of a series of extra-curricular courses on Engineering and Mechatronics. If there is such an
interest, contact between the accompanying teachers and the university should be made well in
advance and the course should be planned as part of a larger set of topics. The course can be
combined with workshops organized at the school by visiting university lecturers. One particular
high school teacher or administrator and one particular university faculty member should be
tasked with the organization of this Master Class and these people can later act as contact
persons and “boundary spanners” for future collaboration. For further collaboration to be
planned, it is advisable that an educational manager from the school attend (part of) the Master
Class in order to witness the effectiveness of the training. If this is not possible, then a report on
the achieved results and the satisfaction of students should be presented to the school
management, together with a proposal for further collaboration.
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